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PPlease read carefully before first use
Please read carefully before first use



WARNINGWARNINGWARNINGWARNING
DO NOT USE WHEN RAINING!
DO NOT OPEN OR EXCHANGE PARTS!
REPAIR ONLY CAN BE CONDUCTED BY STUFF!

NOTI
� Directing device to strong light source (such as sun light) is prohibited under

any condition, including after power down. This will cause malfunction or even
critical damage to the device.

� Avoid shock and impact during operation or transport.

� Device must be in original case during transport and storage. Storage
temperature is between -40℃ to 60℃.

� Typical storage place is cool, dry, ventilated, and without strong electrical or
magnetic field.

� Avoid oil or any chemical liquid on Infrared lens surface. Close lens lid after
operation.

� Export and backup data on PC after operation. Format internal FLASH memory
periodically for best performance.
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1.1.1.1. ProductProductProductProduct SummarySummarySummarySummary
This new generation Infrared Camera (equipped with Uncooled Focal Plan Array
Micro-bolometer) produces crisp thermal image and accurate temperature reading to help
increase system maintenance quality and efficiency in many industries. Crisp thermal
image, accurate temperature reading, clear user interface, reliable product quality, and



affordable cost makes the new standard in Infrared imaging industry!

TypicalTypicalTypicalTypical Application:Application:Application:Application:

� PowerPowerPowerPower Plant:Plant:Plant:Plant:Monitor and diagnose the condition of electrical wire and equipment,
measure surface temperature, detect power leak, and prevent system malfunction

� Electronics:Electronics:Electronics:Electronics:Monitor and control printed circuit board or LED board temperature
during the curing process; Locate poor soldering, track discontinuities, incorrect
component values and power ratings as well as incorrect polarities in the production
place; and other type of applications in electronic fields

� MedicalMedicalMedicalMedical Application:Application:Application:Application: Accurately measure human body temperature in a distance,
critical under a contaminated condition

� OtherOtherOtherOther Applications:Applications:Applications:Applications: Constructions, civil engineering, university research, and etc.

1.1 Standard Item List
Infrared Camera comes with the following standard items and accessories:

Item Name Quantity
Infrared Camera 1
Li-Ion Battery 2
Battery Charger 1
USB Cable 1
Video Cable 1
User Manual 1
Software CD 1

Transport Case 1

2.2.2.2. BatteryBatteryBatteryBattery andandandand ChargerChargerChargerCharger



It is recommended to charge battery immediately when device indicates low power. By
press and move in the indicated direction, user can easily insert and remove battery.

Battery Insertion

Battery Removal

Device comes with two sets of Li-Ion battery and one battery charger. It is strongly
recommended to operate only with the included battery and charger. Use any other brand
charger or Li-Ion battery may cause fire or critical damage.

2.1 Charging Battery
1) Following the direction indicated on battery charger, insert the Li-Ion battery, press

firmly and push all the way in.
2) During charging, the red LED will be on, and when charging is completed, the green

LED will be on instead.



Note: Normally takes 4 hours to completely charge one battery.

2.2 Notes for Using Battery Charger
1) Charging can only be conducted in a cool, dry, room environment, not under direct

sunlight or during rain.
2) Do not short-circuit the battery. Do not place battery with metal material such as key

chain. These may cause short-circuit during transportation.
3) Do not place battery in high temperature environment (≥60℃) or in fire. This may

cause fire or explosion.
4) Do not try to modify or open the battery or the charger.
5) Li-Ion battery has no memory effect, thus unlike Ni-Cd battery, charging can be

conducted at any time.
6) It is recommended to remove battery from charger when charging is completed.

3.3.3.3. PanelPanelPanelPanel FunctionFunctionFunctionFunction SummarySummarySummarySummary
In this manual, “long press” means press and hold button down for about 2 seconds, and
“press” or “short press” means press and release.

3.1 Main Control Panel
As shown in the following image:



1.1.1.1. PowerPowerPowerPower ON/OFFON/OFFON/OFFON/OFF ButtonButtonButtonButton
Long press this button to turn on or off the device.

2.2.2.2. PowerPowerPowerPower LEDLEDLEDLED LightLightLightLight
When device is powered on, the Power LED Light will be on also.

3,3,3,3, 4,4,4,4, 5,5,5,5, 6.6.6.6. DirectionDirectionDirectionDirection ButtonsButtonsButtonsButtons
Up (▲), Down (▼), Left ( ), and Right ( ), 4 direction buttons have different
usage under different mode.
In main manual, direction buttons are used for moving selected items or changing
slide-bar value. In real time Infrared view mode, directions buttons provide one-click
access:
Press to freeze Infrared image and press again to unfreeze
Long press to save current Infrared image
Press ▲ or ▼ to switch between normal view and 2X zoom

After press Hotkey button (refer page 7, 3.3) and in area measurement mode:
� Select area box on screen: select move in menu, press ▲, ▼, , and

moves area box, and select size in menu, press ▲, ▼, resizes area
box.

� Select Color Palette or temperature measurement limit on screen: Press ▲, ▼, to



change, and has no effects.

7.7.7.7. OKOKOKOK (Menu/Confirm)(Menu/Confirm)(Menu/Confirm)(Menu/Confirm) ButtonButtonButtonButton
This button has different functions under different conditions:
� In real time Infrared view mode, press this button opens the main menu.
� In main menu, press this button to confirm operation.
� In real time Infrared view mode, long press this button to manually rectify

measurement result.
� In image viewing mode, long press this button to exit.

Note: After auto rectifying, if device has abnormal noise, long press OK button to perform
manual rectifying usually solves such issues.

8.8.8.8. MICMICMICMIC
Internal MIC records audio annotation.

3.2 Rear Interface Panel
As shown in the following image:

9.9.9.9. ExternalExternalExternalExternal DCDCDCDC InInInIn
External DC requirement is 12V.
10.10.10.10. USBUSBUSBUSB 2.02.02.02.0 InterfaceInterfaceInterfaceInterface
USB2.0 interface transfers data between device and PC.
11.11.11.11. VideoVideoVideoVideo OutputOutputOutputOutput
CVBS standard video output.
12.12.12.12. AudioAudioAudioAudio OutputOutputOutputOutput
Audio output playbacks recorded voice annotation.



3.3 Side View
As shown in the following image:

13.13.13.13. HotkeyHotkeyHotkeyHotkey ButtonButtonButtonButton
Short press Hotkey button to switch between Color Palette, area measurement rectangle,
temperature limits, and long press Hotkey button to turn on/off laser sight.
14.14.14.14. LaserLaserLaserLaser SightSightSightSight
Long press Hotkey button to turn on/off laser sight.
15.15.15.15. SoundSoundSoundSound AlarmAlarmAlarmAlarm BuzzerBuzzerBuzzerBuzzer
Signal sound alarm when reaches temperature limit.

4.4.4.4. QuickQuickQuickQuick StartStartStartStart ReferenceReferenceReferenceReference
4.1 Infrared Image
1. Insert Li-Ion battery correctly.
2. Long press Power button until LED light is on and wait until system finishes

initialization.
3. Remove IR Lens lid if closed, point to target, and adjust focus to get crisp thermal

image.
4. Long press OK button to rectify thermal image.

4.2 Measure Target Temperature
1. Point device to measurement target, and adjust to correct focus. On the upper-right



LCD corner, *=×× displays the spot measurement result. For better accuracy,
long press OK button to perform manual rectify.

2. Select Area (Rect) Measurement to measure max, min, and average temperature
within a rectangle box.

3. It is recommended to press button to freeze thermal image first, and then apply
different and detailed analysis. Press button one more time to unfreeze or long
press button to save current thermal image.

4. Press ▲ button or ▼ button to switch between normal and 2X zoom.
5. When measurement result is outside temperature range, screen display changes to

indicate either below or above temperature range.

4.3 Infrared Image and Voice Annotation
Each thermal image can save up to 40 seconds voice annotation data. Image and voice
annotation can later be reviewed on PC by bundled software. To save Infrared image, first
press button to freeze image, and then long press button again to open the voice
recording menu. If only needs store Infrared image, select Cancel, otherwise select
Record. Press OK button to confirm.

In main menu, File→Save provides the same function.
Note: Select Cancel during voice recording to exit.

4.4 Infrared Image Playback
1. Press OK button to open main menu.
2. Select File→Manage, and select folder to view stored thermal image.
3. When viewing thermal image, press button or button to switch image in

the same folder.

4. The icon indicates voice annotation attached to current thermal image. Press
▲ button to playback.

5. Long press OK button to exit.

4.5 Connect to PC
Connect device to PC using included USB 2.0 cable. Refer IRSee software manual
for additional PC operation instruction. It is recommended to format device
periodically.



5.5.5.5. OperationOperationOperationOperation MenuMenuMenuMenu
5.1 Display Summary
All items can be selected by short pressing the Hotkey button (Note: Long press Hotkey
button will turn on/off laser sight). The selected item is flashing in yellow color. If no
operation in 2 seconds after selection, Hotkey mode will exit automatically.

Thermal Image Screen Shot

1 Zoom indicator
2 5 Area Measure Box
3 Horizontal measure line
4 Spot measure
6 Temperature unit
7 Battery power condition

8 Spot measure result： 1, 2, 3, 4 indicates measure result
for spot 1, 2, 3, 4 respectively.

9 Line measure result
10 Area measure result：Selectable from max, min, and average temperature within the

measure rectangle



11 Line measure curve
12 Line measure cursor: Cursor is vertical when line measure is horizontal and vise

versa
13 15 Temperature range
14 Color Palette

5.2 Main Menu
Menu and sub-menu items:

Press OK button (when not in Hotkey mode) to enter main menu. Note if press OK button
too long, instead of enter main menu, triggers manual rectify.



Main Menu

Using ▲ and ▼ button to select menu item, and selected item is highlighted with white
background. Press OK or button to enter sub-menu. Press button to return to
previous menu or exit.

5.2.1 File
Using File menu to save, playback, delete thermal image and voice annotation.



File Sub-menu

Manage
Select Manage to review saved thermal image, add or edit voice annotation, or delete
thermal image.

File Manage

Folder is automatically created if not exist when saving thermal image. Folder name is
MYYMMDD, and YYMMDD is year, month, and date. For example, Jan 2nd, 2009 folder is
M090102. All thermal images taken in this day is saved in this folder. Thermal image file



name is Phhmmss, and hhmmss is hour, minute, second (according to system time). For
example, P080502 in folder M090102 means the thermal image taken at 08:05:02 time in
Jan 2nd, 2009.
In File Manage window, press ▲ and ▼ button to select items. Selected item is
highlighted with red background. Press and button to switch folder or file when
highlighted. After select thermal image, press Open to view thermal image or Delete to
delete. Press Exit to exit File Manage window.

Saved Thermal Image

Press or button to switch saved thermal image in the same folder. The
icon indicates voice annotation data with current thermal image. Long press ▲ button to
enter Voice Annotation menu. If voice annotation already exists, press Record will record
new voice annotation and erase previously saved one. Press Cancel first to stop
recording then press Save to save.

Voice Annotation



Long press ▼ button to delete thermal image.

Delete Saved Thermal Image
To exit thermal image playback, long press OK button.

Save
Save current thermal image. Freeze image first before saving.

Format
Format the internal FLASH memory. Press OK to confirm or cancel to exit. Format will
erase all saved thermal images. It is recommended to transfer data to PC before format.

5.2.2 Measure
There are 5 items: Spot, Line, Area (Rect), Parameters, and Save Setting in Measure
menu.



Measure Sub-menu

Spot Measure
Press or button to select or deselect. Selected spot is check marked.

Spot Measure Selection



Spot Measure

Measure result on upper-right LCD corner is temperature reading at location marked

with . Can select up to 4 spot locations.

SpotSpotSpotSpot MeasureMeasureMeasureMeasure AttributeAttributeAttributeAttribute
Press Hotkey button until spot marker is flashing in yellow, and then use ▲, ▼,

buttons to move spot location to different directions. Press OK button to enter
Attribute Menu. After 2 seconds with no operation, system will exit to real time Infrared
view screen.

Spot Measure Attribute

Emissivity:Emissivity:Emissivity:Emissivity: Refer Appendix for emissivity of raw materials.



SetSetSetSet Reference:Reference:Reference:Reference: Set current spot as reference point. If selected, all measure result will be
relative value to this spot temperature.

Line Measure
There are 2 line measure options: vertical and horizontal.

HorizontalHorizontalHorizontalHorizontal LineLineLineLine MeasureMeasureMeasureMeasure

Horizontal Line Measure
Horizontal line is temperature sampling line, and upper-right LCD corner displays
temperature measurement reading on vertical cursor line intersection. After using Hotkey
button select line measure, press ▲ and ▼ button to adjust sampling line position, and
press and button to adjust cursor line position. Press OK button to enter
Attribute Menu. After 2 seconds with no operation, system will exit to real time Infrared
view screen.

VerticalVerticalVerticalVertical LineLineLineLine MeasureMeasureMeasureMeasure



Vertical Line Measure

Vertical line is temperature sampling line, and upper-right LCD corner displays
temperature measurement reading on horizontal cursor line intersection. After using
Hotkey button select line measure, press and button to adjust sampling line
position, and press ▲ and ▼ button to adjust cursor line position. Press OK button to
enter Attribute Menu. After 2 seconds with no operation, system will exit to real time
Infrared view screen.

Area (Rect) Measure
Press or button to select or deselect. Selected Area is check marked.

Area (Rect) Measure Selection

AreaAreaAreaArea (Rect)(Rect)(Rect)(Rect) MeasureMeasureMeasureMeasure OperationOperationOperationOperation



Area (Rect) Measure
Measure result on upper-right LCD corner is the temperature measurement result within
the corresponding rectangle. There are 3 measure types: max, min, and average
temperature.

AreaAreaAreaArea (Rect)(Rect)(Rect)(Rect) MeasureMeasureMeasureMeasure AttributeAttributeAttributeAttribute
Press Hotkey button until area rectangle is flashing in yellow. Press OK button to enter
Attribute Menu.

Area (Rect) Measure Attribute

Emissivity:Emissivity:Emissivity:Emissivity: Refer Appendix for emissivity of raw materials.
SetSetSetSet Reference:Reference:Reference:Reference: Set current spot as reference point. If selected, all measure result will be
relative value to this temperature.
MeasureMeasureMeasureMeasure Type:Type:Type:Type: Select between max, min, and average.



Adjust:Adjust:Adjust:Adjust: Adjust rectangle position and size.

Parameters
Change different settings to adjust temperature measurement accuracy. Press ▲ and ▼
button to select different parameters, and press and button to change value.

Parameter Sub-menu

EmissivityEmissivityEmissivityEmissivity
Emissivity varies based on target subject material, surface temperature, surface
roughness, measurement angle, and etc. Press or once to change Emissivity
0.01. Press and hold or will change Emissivity in 0.1 intervals.

DistanceDistanceDistanceDistance
This value can be omitted if target subject is close to device (less than 10m). Otherwise,
set Distance value accordingly to get more accurate temperature reading. Press or

once to change Distance 0.1m. Press and hold or will change Distance in
1m interval.

HumidityHumidityHumidityHumidity
Humidity can be set according to environmental condition. Press or once to
change Humidity 1%. Press and hold or will change Humidity in 10% interval.

AdjustAdjustAdjustAdjust RatioRatioRatioRatio
Due to long time usage of device, the sensitivity of IR detector may decrease. In such
case, it is necessary to adjust ratio value to get more accurate temperature reading.
During calibration, if temperature reading is higher than actual target temperature, change
ratio value lower, and vise versa. Press or once to change ratio value 0.01.
Press and hold or will change ratio value in 0.1 intervals.



AdjustAdjustAdjustAdjust TempTempTempTemp
Under certain condition, it is necessary to adjust temperature reading by a pre-define
value. Normally this option should be left unchanged. Press or once to change
0.1℃. Press and hold or will change this value in 1℃ interval.

Save Setting
All above parameter changes must be saved before power down device. Otherwise,
changes will not be saved for next power on.

5.2.3 Image
There are 5 items: Image Setup, Analysis Setup, Image Reverse, Clear Screen, and
Auto/Manual (L&S) in Image menu.

Image Sub-menu

Image Setup



Image Setup Sub-menu
AlarmAlarmAlarmAlarm SwitchSwitchSwitchSwitch
Press or turns on or off the alarm function. If the Alarm Switch is on, when
target subject within area box has surface temperature exceeding Alarm Temp, device
will alarm with buzzer sound and mark the high temperature location as Alarm Color if
Alarm Color is set.

AlarmAlarmAlarmAlarm TempTempTempTemp
When Alarm Switch is off, this option is disabled. When Alarm Switch is on, Alarm Temp
is the desired alarm temperature. Short press ▲ or ▼ once to change Alarm Temp 0.1
℃. Press and hold ▲ or ▼ will change Alarm Temp in 1℃ interval. Default setting is
37.0℃.

AlarmAlarmAlarmAlarm ColorColorColorColor
Alarm Color can select from Auto, Black, White, Red, Orange, Yellow, Green, Blue, Gray,
and Purple. Default setting is Auto, which is no color alarm.

IsothermIsothermIsothermIsotherm ColorColorColorColor
When this option is Auto, there is no Isothermal display. Otherwise, target subject Infrared
image will change to selected color when temperature is within the range of (Isothermal
Temp ± Isothermal Width/2). Default setting is Auto.

IsothermIsothermIsothermIsotherm TempTempTempTemp
Press or once to change Isothermal Temp 0.1℃ . Press and hold or
will change Isothermal Temp in 1℃ interval. Default setting is 37.0℃.

IsothermIsothermIsothermIsotherm WidthWidthWidthWidth
Adjust Isothermal Width to change the range of Isothermal Color display. Press or

once to change Isothermal Width 0.1℃ . Press and hold or will change



Isothermal Width in 1℃ interval. Default setting is 1.0℃.

ScreenScreenScreenScreen DisplayDisplayDisplayDisplay
When this option is Off, screen display will clear battery condition, temperature unit,
temperature limit, and color palette. Press or to change this option.

Analysis Setup

Analysis Setup Sub-menu

TempTempTempTemp RangeRangeRangeRange
Select Temperature range base on measure target temperature.

IRIRIRIR LensLensLensLens
Select correct IR Lens for best measurement result.

TempTempTempTemp UnitUnitUnitUnit
Select Temperature Unit between ℃, ℉, and K.
℉=9/5*℃+32，K=273.15+℃

AmbientAmbientAmbientAmbient TempTempTempTemp
For more accurate measure result, set Ambient Temp to correct environmental
temperature. Press or once to change Ambient Temp 0.1℃ . Press and hold

or will change Ambient Temp in 1℃ interval.

ReferenceReferenceReferenceReference
Set reference point to display all measure result as relative value.



RefRefRefRef TempTempTempTemp
Manually set a reference temperature for measurement. This option is only active when
set Ref Temp as reference.

Image Reverse
Press OK button to reverse palette for thermal image display. Press OK again to switch
back.

Clear Screen
Clear all screen items except Logo mark.

L&S (Auto/Manual Mode)
Press OK button to switch between auto and manual rectifying. In manual rectifying mode,
upper-left corner of LCD display shows L&S.

5.2.4 Setup
There are 4 items: System Setup, Time & Date, Factory Default, and Information in Setup
menu.



Setup Sub-menu

System Setup
System Setup includes: Language, Auto Rectify, Auto Save, Video, Transparence,
Display Device, Screen Save, and Power Save. Press ▲ and ▼ button to switch
selection, and press and button to adjust value. Active item is highlighted with
red background.

System Setup Sub-menu



LanguageLanguageLanguageLanguage
Select different language options.

AutoAutoAutoAuto RectifyRectifyRectifyRectify
Set the number of seconds to perform next auto-rectify. Set value between 1 to 3000
seconds. Value 0 means disabling auto-rectify feature.

AutoAutoAutoAuto SaveSaveSaveSave
Set the number of seconds to perform next auto-save. Set value between 1 to 3600
seconds. Value 0 means disabling auto-save feature.

VideoVideoVideoVideo
Select between PAL and NTSC.

TransparenceTransparenceTransparenceTransparence
Set to enable or disable menu transparence feature.

DisplayDisplayDisplayDisplay DeviceDeviceDeviceDevice
Select between LCD display and external monitor device. Only one video output device
can be selected at one time, the other one will be disabled.
Note: If accidentally selected external monitor device and LCD display is disabled, power
off and power on device to get LCD display back.

ScreenScreenScreenScreen SaveSaveSaveSave
Set the number of minutes without operation to trigger disabling LCD display to save
power. Select between 5min, 10min, 30min, and None.

PowerPowerPowerPower SaveSaveSaveSave
Set the number of minutes without operation to trigger power off completely. Select
between 5min, 10min, 30min, and None.

Time & Date
Set system date and time. Press OK button to confirm after changes. If Li-Ion battery is
removed for a long time, it is necessary to reset system time and date.



Factory Default
Press OK button to confirm restore to factory default.

Information
Select to display system information.

6.6.6.6. TechnicalTechnicalTechnicalTechnical SpecificationSpecificationSpecificationSpecification
IRIRIRIR

DetectorDetectorDetectorDetector
Detector Type Uncooled FPA

Resolution 160×120
Spectral Range 8～14μm

InfraredInfraredInfraredInfrared
ImageImageImageImage
QualityQualityQualityQuality

Standard Lens 18°×13°/0.15m

Optional Lens 32°×24°/0.05m
12°×9°/0.15m
4°×3°/0.8m

Spatial
Resolution

1mrad/f=25mm

Thermal
Sensitivity

0.10℃, at 30℃

Frame-rate 50/60Hz
Focusing Manual

Digital Zoom 2×
Pixel Pitch 25μm

AccuracyAccuracyAccuracyAccuracy
andandandand
ModeModeModeMode

Temperature
Range

-20℃～+600℃

Accuracy ±2℃ or ±2%
Rectify Auto/Manual

Measure Mode Adjustable 4 spot, 3 area, horizontal, vertical line
measure, isothermal display, and sound/color
alarm

MeasureMeasureMeasureMeasure
Color Palette 12 Colors selectable

Image Setup Auto/Manual adjustable
System Setup Date, Time, Language
Emissivity Manual adjustable



Ambient
Correction

Auto

Atmospheric
Correction

Auto

DisplayDisplayDisplayDisplay LCD 3.5" Color LCD
StorageStorageStorageStorage Storage Media (Internal

Flash Memory)
Up to 1500 images

Storage Feature Auto/Manual

File Type JPEG with 14 bits data
Voice Annotation 40 Seconds voice recording per image

LaserLaserLaserLaser Classification Class 2, 1mW/635nm Red
PowerPowerPowerPower
SupplySupplySupplySupply

Battery Type Rechargeable Li-Ion Battery

Battery Operating Time 3 Hours

Device Power Li-Ion battery with external charger
External power supply (optional)

Power Save Included
External Power 12V DC

OperatingOperatingOperatingOperating
ConditionConditionConditionCondition

Operation Temperature -20℃~ +50℃

Storage Temperature -40℃~ +60℃

Humidity ≤90％ (non condensing)
Resistant Level IP54

SizeSizeSizeSize andandandand
WeightWeightWeightWeight

Weight 660g

Size (L×W×H) 330mm×95mm×86mm

7.7.7.7. TechnicalTechnicalTechnicalTechnical SupportSupportSupportSupport
For common mistakes and issues during operation, please refer the following form. If



issue cannot be resolved, please contact our technical support department.

ProblemProblemProblemProblem PossiblePossiblePossiblePossible SolutionSolutionSolutionSolution

Device cannot
power up

� No battery or battery not installed
correctly.

→ Install battery correctly.
� Battery power is low.

→ Change battery or charge.
� Device power off protection

→ Wait 5 seconds to power up.

Device power off
automatically

� Battery power is low.
→ Change battery or charge.

Power consumption is too
high

� Ambient temperature is low.
� Battery is not fully charged.

→ Charge battery fully first.
� Battery may already reach end of life.

(300 usage cycles)
→ Switch to new battery.

No thermal image � Lens lid may be closed.
→ Remove lens lid.

Thermal image is black and
white only

� Black & white palette may be
selected.
→ Change palette.

8.8.8.8. Appendix:Appendix:Appendix:Appendix: EmissivityEmissivityEmissivityEmissivity ofofofof RawRawRawRaw MaterialMaterialMaterialMaterial

For reference purpose only
MaterialMaterialMaterialMaterial SurfaceSurfaceSurfaceSurface TempTempTempTemp ((((℃)))) EmissivityEmissivityEmissivityEmissivity

((((εεεε))))
Aluminum Raw 100 0.20

Oxidized 100 0.55
Brass Brown polished 20 0.40

Raw 38 0.22



Oxidized 100 0.61
Copper Oxidized 20 0.78
Iron Oxidized 100 0.74

Rust 25 0.65
Cast Iron Oxidized 200 0.64

Raw 100 0.21
Wrought Iron Rough 25 0.94

Polished 38 0.28
Nickel Oxidized 200 0.37

Stainless Steel Oxidized 60 0.85

Steel 800℃ Oxidized 200 0.79
Brick -- 20 0.93

Concrete -- 20 0.92
Glass Smooth 20 0.94
Paint White 100 0.92

Black 100 0.97
16 Color average 100 0.94

Carbon Smoke black 25 0.95

Candle smoke 20 0.95
Black-lead rough 20 0.98

Paper White 20 0.93
Soil Dry 20 0.90
Wood Polished 30 0.90
Water -- 30 0.96
Human Skin 32 0.98
China Fine 21 0.90

Rough 21 0.93

Please read carefullyore first


